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Chapter 1 Introduction

1.1 Overview

This manual describes how to use the Renesas Flexible Software Package (FSP) for writing
applications for the RA microcontroller series.

1.2 How to Read this Manual

For help getting started with the FSP, see:
e Starting Development
To learn about the FSP architecture and about board and chip-level support included in the FSP, see:

e FSP Architecture
e MCU Board Support Package

For user guides describing the FSP modules, see:
e Modules
For shared interface APl documentation, see:

e |nterfaces

1.3 Documentation Standard

Each module user guide outlines the following:

e Features: A bullet list of high level features provided by the module.

e Configuration: A description of module specific configurations available in the RA
Configuration editor.

e Usage Notes: Module specific documentation and limitations.

e Examples: Example code provided to help the user get started.

¢ APl Reference: Usage notes for each APl in the module, including the function prototype and
hyperlinks to the interface documentation for parameter definitions.

Interface documentation includes typed enumerations and structures-including a structure of
function pointers that defines the API-that are shared by all modules that implement the interface.

Introduction to FSP

Purpose

The Renesas Flexible Software Package (FSP) is an optimized software package designed to provide
easy to use, scalable, high quality software for embedded system design. The primary goal is to

R11UMO0148EU0100 Revision 1.00 .IENESAS Page 7 /1,525
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provide lightweight, efficient drivers that meet common use cases in embedded systems.
Quality

FSP code quality is enforced by peer reviews, automated requirements-based testing, and
automated static analysis.

Ease of Use

The FSP provides uniform and intuitive APIs that are well documented. Each module is supported
with detailed user documentation including example code.

Scalability

FSP modules can be used on any MCU in the RA family, provided the MCU has any peripherals
required by the module.

FSP modules also have build time configurations that can be used to optimize the size of the module
for the feature set required by the application.

R11UMO0148EU0100 Revision 1.00 .IENESAS Page 8/1,525
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Chapter 2 Starting Development

2.1 Starting Development Introduction

The Renesas Flexible Software Package (FSP) provides a host of efficiency enhancing tools for
developing projects targeting the Renesas RA series of MCU devices. e2 studio provides a familiar
development cockpit from which the key steps of project creation, module selection and
configuration, code development, code generation, and debugging are all managed. FSP runs within
e2 studio and enables the module selection, configuration, and code generation steps. FSP uses a
Graphical User Interface (GUI) to simplify the selection, configuration, code generation and code
development of high level modules and their associated Application Program Interfaces (APIs) to
dramatically accelerate the development process.

The wealth of resources available to learn about and use e2 studio and FSP can be overwhelming on
first inspection, so the following section provides a Getting Started Guide with a list of the most
important first steps. Following these highly recommended first 10 steps will bring you up to speed
on the development environment in record time. Even experienced developers can benefit from the
use of this guide, to learn the terminology that might be unfamiliar or different from previous
environments.

2.1.1 Getting Started with e2 studio and FSP

This section describes how to use Renesas e2 studio to develop applications with the Renesas
Flexible Software Package (FSP). Here is the recommended sequence for quickly Getting Started with
using e2 when developing with the RA MCU Family:

1. Read over the section What is e2 studio?, up to but not including e2 studio Prerequisites.
This will provide a description of the various windows and views to use e2 to create a
project, add modules and threads, configure module properties, add code, and debug a
project. It also describes how to use key coding 'accelerators' like Developer Assist (to drag
and drop parameter populated API function calls right into your code), a context aware
Autocomplete (to easily find and select from suggested enumerations, functions, types, and
many other coding elements), and many other similar productivity enhancers.

2. Read over the FSP Architecture sections FSP Architecture, FSP Modules and FSP Stacks.
These provide the basic background on how FSP modules and stacks are used to construct
your application. Understanding their definitions and the theory behind how they combine
will make it easier to develop with FSP.

3. Read over a few "API Reference" sections to see how to use API function calls, structures,
enumerations, types and callbacks. These user guides provide the information you will use
to implement your project code. (Much of the details are provided with Developer
Assistance, covered in step 5, below.

4. If you don't have a kit. you can order one using the link included in the e2 studio
Prerequisites section. Then, if you haven't yet downloaded and installed e2 studio and FSP,
use the link included in the e2 studio Prerequisites section to download the tools. Then you
can build and debug a simple project to prove out you installation, tool flow, and the kit.
The simple "Blinky" project, that blinks an LED on and off, is located in the Tutorial: Your
First RA MCU Project - Blinky section. Follow the instructions for importing and running this
project. It will use some of the key steps for managing projects within e2 and is a good way
to learn the basics.

R11UMO0148EU0100 Revision 1.00 .IENESAS Page 9/1,525
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5. Once you have successfully run Blinky you have a good starting point for using FSP for more
complex projects. The Watchdog Timer hands-on lab, available in the Tutorial: Using HAL
Drivers - Programming the WDT section, shows how to create a project from scratch and
use FSP API functions, and demonstrates the use of some of the coding efficiency tools like
Developer Assistance and Autocomplete. Run through this lab to establish a good starting
point for developing custom projects.

6. The balance of the FSP Architecture sections, those not called out in step 2 above, contain
additional reference material that may be helpful in the future. Scan them over so you know
what they contain, in case you need them.

7. The balance of the e2 studio User Guide, starting with the What is a Project? section up to
Writing the Application section, provides a detailed description of each of the key steps,
windows, and entries used to create, manage, configure, build and debug a project. Most of
this will be familiar after doing the Blinky and WDT exercises from steps 4 and 5 above.
Skim over these references so you know to come back to them when questions come up.
Make sure you have a good grasp of what each of the configuration tabs are used for since
that is where the bulk of the project preparation work takes place prior to writing code.

8. Read over the Writing the Application section to get a short introduction to the steps used
when creating application code with FSP. It covers both RTOS-independent and RTOS-
dependent applications. The Tutorial: Using HAL Drivers - Programming the WDT section is
a good introduction to the key steps for an RTOS-independent application. Make sure you
have run through it at least once before doing a custom project.

9. Scan the Debugging the Project section to see the steps required to download and start a
debug session.

10. Explore the additional material available on the following web pages and bookmark the
resources that look most valuable to you:
a. RA Landing Page: https://www.renesas.com/ra
b. FSP Landing Page: https://www.renesas.com/fsp

2.2 e2 studio User Guide

2.2.1 What is e2 studio?

Renesas e2 studio is a development tool encompassing code development, build, and debug. e2
studio is based on the open-source Eclipse IDE and the associated C/C++ Development Tooling
(CDT).

When developing for RA MCUs, e2 studio hosts the Renesas Flexible Software Package (FSP). FSP
provides a wide range of time saving tools to simplify the selection, configuration, and management
of modules and threads, to easily implement complex applications. The time saving tools available in
e2 studio and FSP include the following:

* A Graphical User Interface (GUI) (see Adding Threads and Drivers) with numerous wizards
for configuring and auto-generating code

* A context sensitive Autocomplete (see Tutorial: Using HAL Drivers - Programming the WDT)
feature that provides intelligent options for completing a programming element

e A Developer Assistance tool for selection of and drag and drop placement of API functions
directly in application code

e A Smart Manual provides driver and device documentation in the form of tooltips right in
the code

e An Edit Hover feature to show detailed descriptions of code elements while editing

e A Welcome Window with links to example projects, application notes and a variety of other
self-help support resources

e An Information Icon from each module is provided in the graphic configuration viewer that
links to specific design resources, including code 'cheat sheets' that provide useful starting
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points for common application implementations.

RENESAS

e’ studio

v7.6.0

Loading org.eclipse.oomph.setup.ui £ BUILTON

|
Figure 1: e2 studio Splash Screen

e2 studio organizes project work based on Perspectives, Views, Windows, Panes, and Pages
(sometimes called Tabs). A window is a section of the e2 studio GUI that presents information on a
key topic. Windows often use tabs to select sub-topics. For example, an editor window might have a
tab available for each open file, so it is easy to switch back and forth between them. A window Pane
is a section of a window. Within a window, multiple Panes can be opened and viewed simultaneously,
as opposed to a tabbed window, where only individual content is displayed. A memory-display
Window, for example, might have multiple Panes that allow the data to be displayed in different
formats, simultaneously. A Perspective is a collection of Views and Windows typical for a specific
stage of development. The default perspectives are a C/C++ Perspective, an FSP Configuration
Perspective and a Debug Perspective. These provide specific Views, Windows, Tabs, and Panes
tailored for the common tasks needed during the specific development stage. These three default
perspectives are each illustrated in the below screen shots, along with graphic indicators helpful in
identifying example Views, Windows, Tabs and Panes.

File Edit Mavigate Search Project RenesasViews Run Window Help

D684 [&] (][] [Foms

| om | Rece. 5 RA Configuration Quick Access
[ Project Explorer 53 = B ) &k [Blinky] RA Configuration 53 = EI\ % Package 53 [CRCIEAN: R - = EI\

|| [ Blinky Debug (1) v

& -

. Bl s Summary [+ L2 3 a4 s & 7 s »
v Blinky Generate Project Content] R 7 - p S —— -

&l Includes i

Bra Project Summary A & [Fuos | pacz | paos | paos || p2oe || pace || Pzxs |ssusgusaDe| peos |2

& ragen RENESAS < [pusz | pace (0 | wa0s (lpaor | paso [ pace | mogy | mesz [l meez [ €

(S src Board: Custom User Board (Any Device)

= ra_cfg Device: RIFAGM1AD2CLY o (e | pazs | pase | paos (lrese |[pese | pace | ees | vss [ wee [0

(= seript Toolchain: GCC ARM Embedded © [ vee || Peuo || Pee ||Puis [[PLas [P0 [l Pasd | pess | p2as

2 Blinky Debug (1).Jaunch
5% configurationxml

2 R7FABMIAD2CL).pincfg
() Developer Assistance

Toolchain Version: 8.3.1.20190703 Project Configuration
FSP Version: 0.8.0 Editor

£ | e | vss || poe | eeon || peco (| ez || pace

& |pags | pos | 107 || esos |[esos || esce |[poce

Selected software components Fiot | Paoe | Paos || Prco

Custom Board Support Files v0.8.0 * |paca | psme | vas | poes v [ Foce Pan || Pooe
VG Port w080 e [ s | vee [ e mare s [ e [ o |
. Board Support Package Common Files v0.8.0 . < — — =
Project Arm CMSIS Version 5 - Core (M) v5.5.1 )
Explorer Board support package for RTFAGM1AD2CLY V0.0 "‘ RIFA6M1Asod J - 100LGA (Top View)
View Connection status:

@ %:r:(m [ Jwerrirg
YoufT® ﬁ Package
- Support A = View

Summary | BSP | Clocks | Pins | Interrupts | Event Links | Stacks Components

. A Pk /
Figure 2: Default Perspective

In addition to managing project development, selecting modules, configuring them and simplifying

User’s Manual
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code development, e2 studio also hosts the engine for automatically generating code based on
module selections and configurations. The engine continually checks for dependencies and
automatically adds any needed lower level modules to the module stack. It also identifies any lower
level modules that require configuration (for example, an interrupt that needs to have a priority
assigned). It also provides a guide for selecting between multiple choices or options to make it easy
to complete a fully functional module stack.

The Generate Project Content function takes the selected and configured modules and automatically
generates the complete and correct configuration code. The code is added to the folders visible in
the Project Explorer window in e2 studio. The configuration.xml file in the project folder holds all
the generated configuration settings. This file can be opened in the GUI-based RA Configuration
editor to make further edits and changes. Once a project has been generated, you can go back and
reconfigure any of the modules and settings if required using this editor.

15 Project Explorer £3 ]

& -

=

~ 1% MyProject [Debug]
3 Binaries
5l Includes
= ra
2 ra_gen
8 src
= Debug

= ra_cfg

= script
4k configurationaml

=| MyProject Debug,jlink
= R7FAGM3AH3CFC.pincfg
=/ ra_cfgixt

= RABM3-EK.pincfg

(7) Developer Assistance

Figure 3: Project Explorer Window showing generated folders and configuration.xml file

2.2.2 e2 studio Prerequisites

2.2.2.1 Obtaining an RA MCU Kit

To develop applications with FSP, start with one of the Renesas RA MCU Evaluation Kits. The Renesas
RA MCU Evaluation Kits are designed to seamlessly integrate with the e2 studio.

Ordering information, Quick Start Guides, User Manuals, and other related documents for all RA MCU
Evaluation Kits are available at https://www.renesas.com/ra.

2.2.2.2 PC Requirements
The following are the minimum PC requirements to use e2 studio:

e Windows 10 with Intel i5 or i7, or AMD A10-7850K or FX

e Memory: 8-GB DDR3 or DDR4 DRAM (16-GB DDR4/2400-MHz RAM is preferred)

e Minimum 250-GB hard disk
2.2.2.3 Installing e2 studio, platform installer and the FSP package
Detailed installation instructions for the e2 studio and the FSP are available on the Renesas website
https://www.renesas.com/fsp. Review the release notes for e2 studio to ensure that the e2 studio
version supports the selected FSP version. The starting version of the installer includes all features of

the RA MCUs.

2.2.2.4 Choosing a Toolchain
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e2 studio can work with several toolchains and toolchain versions such as the GNU ARM compiler,
AC6. A version of the GNU ARM compiler is included in the e2 studio installer and has been verified
to run with the FSP version.

2.2.2.5 Licensing

FSP licensing includes full source code, limited to Renesas hardware only.

2.2.3 What is a Project?

In e2 studio, all FSP applications are organized in RA MCU projects. Setting up an RA MCU project
involves:

1. Creating a Project
2. Configuring a Project

These steps are described in detail in the next two sections. When you have existing projects
already, after you launch e2 studio and select a workspace, all projects previously saved in the
selected workspace are loaded and displayed in the Project Explorer window. Each project has an
associated configuration file named configuration.xml, which is located in the project's root directory.

15 Project Explorer £3 ]

& -

=S
~ 1% MyProject [Debug]

3 Binaries

5l Includes

= ra

2 ra_gen

8 src

= Debug

= ra_cfg

= script
507 configuration.xml

=| MyProject Debug,jlink
= R7FAGM3AHICFC.pincfg
=/ ra_cfgixt

= RABM3-EK.pincfg

(7) Developer Assistance

Figure 4: e2 studio Project Configuration file

Double-click on the configuration.xml file to open the RA MCU Project Editor. To edit the project
configuration, make sure that the RA Configuration perspective is selected in the upper right hand
corner of the e2 studio window. Once selected, you can use the editor to view or modify the
configuration settings associated with this project.

£ | B8 C/C++ {5 RA Configuration

Figure 5: e2 studio RA Configuration Perspective

Note
Whenever the RA project configuration (that is, the configuration.xml fil€) is saved, a verbose RA Project Report
file (ra_cfg.txt) with all the project settings is generated. The format allows differences to be easily viewed using a
text comparison tool. The generated file islocated in the project root directory.
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[ Project Explorer 32 = (a5 =| ra_cfg.tat 52
=) ﬁl gy = i § RA Configuration
Gt 2 Board "EK-RAGM3"
< z
e 1 MyProject [Debug] 3 R7FAGMBAHICFC
i, Binaries 4 part_number: R7FAGM3AHICFC
[ Includes 5 rom_size bytes: 2897152
B ra 6 ram_size bytes: 65536@
2 ra_gen 7 data_flash_size_bytes: 65536
@ 5 package_style: LQFP
ste package_pins: 176
(= Debug
(= ra_cfg RAGM3
[ script series: g

{5 configurationxml
= MyProject Debug.jlink

|=| RAGM3-EK.pincfg
(?) Developer Assistance

RAGM3 Family

OFS@ register settings:
OFS@ register settings:
OF5@ register settings:

i 5 OFS@ register settings: Independent WDT: Start Mod
TFABM3AHICFC.pincfg OFS® register settings: Independent WDT: Timeout P
= OFS@ register settings: Independent WDT: Dedicated

Independent WDT: Window En
Independent WDT: Window St
Independent WDT: Reset Int

OF5@ register settings:
OF5@ register settings:
OFS@ register settings:
24 OFS@ register settings:
25 OF5@ register settings:
< > <

Independent WDT: Stop Cont
WDT: Start Mode Select: St
DT: Timeout Period: 16334
DT: Clock Frequency Divis
WDT: Window End Position:

Figure 6: RA Project Report

The RA Project Editor has a number of tabs. The configuration steps and options for individual tabs
are discussed in the following sections.

Note
The tabs available in the RA Project Editor depend on the e2 studio version.

18} [MyProject] RA Configuration 52 imal=:

Summary Generate Project Content
Project Summary ;
RENESAS X
Board: EK-RABGM3
Device: R7FABM3AH3ICFC
Toolchain: GCC ARM Embedded
Toolchain Version: = -2 &=Z%
FSP Version: LI |

Selected software components

RAGM3-EK Board Support Files P 15
Simple application that blinks an LED. No RTOS included LR i
Arm CMSIS Version 5 - Core (M) -

IO Port LI )
Board Support Package Common Files iy T3
Board support package for RTFAGM3AH3ICFC Foelw?

1Summary BSP | Clocks | Pins | Interrupts | Event Links Staclcs'ComponentsI

Figure 7: RA Project Summary tabs

e Click on the YouTube icon to visit the Renesas FSP playlist on YouTube
e Click on the Support icon to visit RA support pages at Renesas.com
¢ Click on the user manual (owl) icon to open the RA software package User's Manual

2.2.4 Creating a Project

During project creation, you specify the type of project, give it a project name and location, and
configure the project settings for version, target board, whether an RTOS is included, the toolchain
version, and the beginning template. This section includes easy-to-follow step-by-step instructions
for all of the project creation tasks. Once you have created the project, you can move to configuring
the project hardware (clocks, pins, interrupts) and the parameters of all the modules that are part of
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your application.
2.2.4.1 Creating a New Project
For RA MCU applications, generate a new project using the following steps:

1. Click on File > New > RA C/C++ Project.

B Workspace - &¥ studio
File Edit Mavigate Search Project RenesasVWiews Run Window Help

New Alt+Shift+N > = RA C/C++ Project

Open File... % Project...
() Open Projects from File System... % Eample.
Close Ctrl+W % Other.. Ctri+N

Figure 8: New RA MCU Project

Then click on the type of template for the type of project you are creating.

Mew RA C/C++ Project ul X

Templates for New RA C/C++ Project

Renesas RA C Executable Project
C/C++ == A C Brecutable Project for Renesas RA.

Renesas RA C Library Project
=== A C Library Project for Renesas RA.

Renesas RA C Project Using RA Librar
) 9 ¥
F== Creates o C application project which uses an existing RA library project

Renesas RA C++ Executable Project
FE A C++ Executable Project for Renesas RA.

enesas ++ LiDrar roj
R RA C++ Library Project
== A C++ Library Project for Renesas RA.

Renesas RA C++ Project Using RA Librar
] 9 Y
FSZ Creates o C++ applicatior. project which uses an existing RA library project

@' < Back Mext > Einish Cancel

Figure 9: New Project Templates

2. Select a project name and location.
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ﬁ e stucio - Project Configuratior (RA C Executable Project) [m] *
e2 studio - Project Configuration (RA C Executable Project) —
Specify the new project details.
Praject Toolchains
Projectname | MyProject GCC ARM Embedded
Use default location
D:\FSPAFSP_Workspace\MyProject Browse.
default
@ < Back Next » Finish Cancel

Figure 10: RA MCU Project Generator (Screen 1)

3. Click Next.
2.2.4.2 Selecting a Board and Toolchain
In the Project Configuration window select the hardware and software environment:

1. Select the FSP version.
2. Select the Board for your application. You can select an existing RA MCU Evaluation Kit or
select Custom User Board for any of the RA MCU devices with your own BSP definition.

3. Select the Device. The Device is automatically populated based on the Board selection.
Only change the Device when using the Custom User Board (Any Device) board
selection.

. To add threads, select RTOS, or No RTOS if an RTOS is not being used.

. The Toolchain selection defaults to GCC ARM Embedded.

. Select the Toolchain version. This should default to the installed toolchain version.

. Select the Debugger. The J-Link ARM Debugger is preselected.

<o u b

8. Click Next.
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B8 <2 studio - Praject Configuration (RA € Executable Project) m] X

e2 studio - Project Configuration (RA C Executable Project)
Select the board support that you require,

Device Selection

FSP version: | 0.8.0-rc.0 Eoard Dctalty

et TR

Device: R7FABM3IAH3ICFC

RTOS: No RTOS &0
Select Tools Available Tools
Toolchain: GCC ARM Embedded ~ GCC ARM Embedded
Toolchain version: | 8.3.1.20190703 ~ 831 2019070

7.3.1.20180622

Debugger: J-Link ARM s 7.2.1.20170904
4.9.3.20150529

w Debuggers
J-Link ARM

w Smart Manual
10 Registers Supported
Software Manual Supported

@ Help < Back MNext > Finish Cancel

Figure 11: RA MCU Project Generator (Screen 2)

Click on the Help icon (?) for user guides, RA contents, and other documents.

2.2.4.3 Selecting a Project Template

In the next window, select a project template from the list of available templates. By default, this
screen shows the templates that are included in your current RA MCU pack. Once you have selected
the appropriate template, click Finish.

Note
If you want to devel op your own application, select the basic template for your board, Bare Metal - Minimal.

e studio - Project Configuration (RA C Executable Project) O X

e2 studio - Project Configuration (RA C Executable Project)
Select the type of project you wish to create.

Project Template Selection

O] 4. Bare Metal - Blinky

Bare metal FSP project that includes BSP and will blink LEDs if available. This project will
initialize clocks, pins, stacks, and the C runtime environment.

[Renesas.RA0.8.0-rc.0.pack]
® (} Bare Metal - Minimal

Bare metal FSP project that includes BSP. This project will initialize clocks, pins, stacks, and
the C runtime environment.

[Renesas.RA.0.8.0-rc.0.pack]

Code Generation Settings
Use RA Code Formatter

':?’\,‘ MNext > Finish Cancel
Figure 12: RA MCU Project Generator (Screen 3)

When the project is created, e2 studio displays a summary of the current project configuration in the
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RA MCU Project Editor.

{8 [MyProject] RA Configuration 33 )

Summar
y Generate Project Content

Project Summary

RENESAS ~
Board: EK-RAGM3
Device: R7FABM3AH3CFC
Toolchain: GCC ARM Embedded
Toolchain Version: = -0 &=%
FSP Version: =1

Selected software components

RABM3-EK Board Support Files Tt 1

Simple application that blinks an LED. No RTOS included. =Huaz

Arm CMSIS Version 5 - Core (M) .

/O Port LI ) S

Board Support Package Common Files Pl " s o
Board support package for RTFABM3AH3CFC ol

lSummary BSP | Clocks Pins | Interrupts | Event Links | Stacks Cumpunentsl

Figure 13: RA MCU Project Editor and available editor tabs

On the bottom of the RA MCU Project Editor view, you can find the tabs for configuring multiple
aspects of your project:

e With the BSP tab, you can change board specific parameters from the initial project
selection.

e With the Clocks tab, you can configure the MCU clock settings for your project.

e With the Pins tab, you can configure the electrical characteristics and functions of each
port pin.

e With the Stacks tab, you can add FSP modules for non-RTOS applications and configure the
modules. For each module selected in this tab, the Properties window provides access to
the configuration parameters, interrupt priorities, and pin selections.

* With the Interrupt tab, you can add new user events/interrupts.

e With the Event Links tab, you can configure events used by the Event Link Controller.

e The Components tab provides an overview of the selected modules. You can also add
drivers for specific FSP releases and application sample code here.

The functions and use of each of these tabs is explained in detail in the next section.
2.2.5 Configuring a Project

Each of the configurable elements in an FSP project can be edited using the appropriate tab in the
RA Configuration editor window. Importantly, the initial configuration of the MCU after reset and
before any user code is executed is set by the configuration settings in the BSP, Clocks and Pins
tabs. When you select a project template during project creation, e2 studio configures default values
that are appropriate for the associated board. You can change those default values as needed. The
following sections detail the process of configuring each of the project elements for each of the
associated tabs.
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18} [MyProject] RA Configuration 53

Summary

Project Summary

Board: EK-RAGM3

Device: R7FABM3AH3CFC
Toolchain: GCC ARM Embedded
Toolchain Version: = -0 &=%

FSP Version: =1

Selected software components

]

Generate Project Content

RENESAS

RABM3-EK Board Support Files Tt 1
Simple application that blinks an LED. No RTOS included. =Huaz
Arm CMSIS Version 5 - Core (M)

/O Port LI ) S
Board Support Package Common Files Pl " s
Board support package for RTFABM3AH3CFC [ 5

1Summary BSP | Clocks Pins | Interrupts | Event Links | Stacks Compunentsl

2.2.5.1 Configuring

~

Figure 14: RA MCU Project Editor and available editor tabs

the BSP with e2 studio

The BSP tab shows the currently selected board (if any) and device. The Properties view is located in
the lower left of the Project Configurations view as shown below.

Note

If the Properties view is not visible, click Window > Show View > Properties in the top menu bar.

EK-RAGM3

Property

~ R7FAGM3AH3CFC
part_number
rom_size_bytes
ram_size_bytes
data_flash_size_bytes
package_style
package_pins

~ RAEM3
series

~ RABM3 Family
OFS0 register settings
OF51 register settings
MPU

~ RA Common
Main stack size (bytes)

Settings

Value

RTFASM3AH3CFC
2097152

655360

65536

LOFP

176

6

0400

Heap size (bytes) - A minimum of 4K 0

MCU Vee (mV)

Parameter checking

Assert Failures

Error Log

ID Code Made

ID Code (32 Hex Characters)
Soft Reset

PFS Protect

Main Oscillator Wait Time
Main Oscillator Clock Source
Subclock Populated

3300

Disabled

Return FSP_ERR_ASSERTION
Mo Error Log

Unlocked (Ignore ID}

Disabled

Enabled

32768 us

Crystal or Resonator
Populated

Figure 15: Configuration BSP tab

The Properties view shows the configurable options available for the BSP. These can be changed
as required. The BSP is the FSP layer above the MCU hardware. e2 studio checks the entry fields to
flag invalid entries. For example, only valid numeric values can be entered for the stack size.

When you click the Generate Project Content button, the BSP configuration contents are written
to ra_cfg/fsp_cfg/bsp/bsp_cfg.h
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This file is created if it does not already exist.

Warning
Do not edit this file as it is overwritten whenever the Generate Project Content button is
clicked.

2.2.5.2 Configuring Clocks

The Clocks tab presents a graphical view of the MCU's clock tree, allowing the various clock dividers
and sources to be modified. If a clock setting is invalid, the offending clock value is highlighted in
red. It is still possible to generate code with this setting, but correct operation cannot be guaranteed.
In the figure below, the USB clock HOCO has been changed so the resulting clock frequency is 24
MHz instead of the required 48 MHz. This parameter is colored red.

{5 *IMyProject] RA Configuration 53

Clocks Configuration

PLL Sre: XTAL v > pCLKA Div /2 < —{ pcLia 120mH:z

PLL Div /2 t - > PCLKE Div /4 w —{pcLi somtz

PLL Mul xZO.i(’) v > pCLIC Div /4 N
[ USBMCLK 24MHz | | [PLL2sombz ! Clock Sre: PLL « <= PCLKD Div /2 v—s{pakp oM
HOCO 20MHz v SDCLKout On —{ spcLkout 120MHz

"= FCLK Div /4 ~ —)| FCLK 60MHz

CLKOUT Disabled ~ —= CLKOUT Div /1 v —>| CLKOUT 0Hz
Summary | BSP Pins | Interrupts | Event Links Stacks  Components

Figure 16: Configuration Clocks tab

When you click the Generate Project Content button, the clock configuration contents are written
to: ra_gen/bsp_clock _cfg.h

This file will be created if it does not already exist.

Warning
Do not edit this file as it is overwritten whenever the Generate Project Content button is
clicked.

2.2.5.3 Configuring Pins

The Pins tab provides flexible configuration of the MCU's pins. As many pins are able to provide
multiple functions, they can be configured on a peripheral basis. For example, selecting a serial
channel via the SCI peripheral offers multiple options for the location of the receive and transmit pins
for that module and channel. Once a pin is configured, it is shown as green in the Package view.

Note
If the Package view window is not open in €2 studio, select Window > Show View > Pin Configurator > Package
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from the top menu bar to open it.

The Pins tab simplifies the configuration of large packages with highly multiplexed pins by
highlighting errors and presenting the options for each pin or for each peripheral. If you selected a
project template for a specific board such as the RA6M3, some peripherals connected on the board

are preselected.

8% *[MyProject] RA Configuration 2

Pins Configuration

Select pin configuration

RAGM3-EK.pincfg

Pin Selection
Hpeﬁ\tertaxt & | B

v« Connectivity:5Cl A
sCio
sCi
sCI2

v SCI3
5Cl4
SCIs
SCIE

v SCI7
sCia
sCIg

i CannactnineSl Y

<

Summary | BSP | & Clocks Interrupts | Event Links | Stacks | Compeonents

<

Generate data:

Pin Configuration

Module name:

Usage:
Pin Group Selection:
Operation Mode:

Input/Qutput

£

=

g_bsp_pin_cfg

scI7

When using Simple 12C mode, ensure port ¢
open drain.

When switching between 12C and other mo
_Conly ~

Asynchronous UART ~

v 613

v (PRl

- |[%; Pin Conflicts 52

Figure 17: Pins Configuration

&1 Package 32

The pin configurator includes a built-in conflict checker, so if the same pin is allocated to another
peripheral or I/O function the pin will be shown as red in the package view and also with white cross
in a red square in the Pin Selection pane and Pin Configuration pane in the main Pins tab. The
Pin Conflicts view provides a list of conflicts, so conflicts can be quickly identified and fixed.

In the example shown below, port P611 is already used by the CAC, and the attempt to connect this
port to the Serial Communications Interface (SCI) results in a dangling connection error. To fix this

error, select another port from the pin drop-down list or disable the CAC in the Pin Selection pane
on the left side of the tab.
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{8} *[MyProject] RA Configuration 52 -

Pins Configuration
g Generate Project Content

Select pin configuration Pins Tutorial & ~ &),

RABM3-EK.pincfg » Generate data: | g_bsp_pin_cfg
Pin Selection Pin Configuration
type filker text i | H
~ B Connectivity:5CI ~ Operation Mode: Simple 5P| v &
5CI0
scn Input/Qutput
5CI2
R TXD_MOSE: ¥ | P613 > C“>:
SCI4 RAD_MISO: v |P614 ¥ =
5CI5 |
s SCK: v |PB12 > =d
B scr €S TS 55 mERel T ed
5CI8 i .
scio L None
v Connectivity:SPI MNone V’
Connecti
v <

e sl

Summary |BSP | & Clocks | @ Pins| Interrupts | Event Links | Stacks | Components |

Figure 18: e2 studio Pin configurator

The pin configurator also shows a package view and the selected electrical or functional
characteristics of each pin.

&1 Package 3 ‘._ﬂvlﬁv@vl:'ﬁl
Connection Status
Drive Capacity

§HEEEEE
v
0aag q Mode

Output Type
Pull Up

RIFAGM3AwaFC
176LOFP

[Top View)

Figure 19: e2 studio Pin configurator package view

When you click the Generate Project Content button, the pin configuration contents are written
to: ra_gen\bsp_pin_cfg.h

This file will be created if it does not already exist.

Warning

Do not edit this file as it is overwritten whenever the Generate Project Content button is
clicked.

R11UMO0148EU0100 Revision 1.00 .IENESAS Page 22 /1,525
Apr.5.20



Flexible Software Package User’s Manual

Starting Development > e2 studio User Guide > Configuring a Project > Configuring Pins

To make it easy to share pinning information for your project, e2 studio exports your pin
configuration settings to a csv format and copies the csv file to ra_gen/<MCU package>.csv.

2.2.5.4 Configuring Interrupts

You can use the Properties view in the Stacks tab to enable interrupts by setting the interrupt
priority. Select the driver in the Stacks pane to view and edit its properties.

{é} *[MyProject] RA Configuration &3 =0

Stacks Configuration
g Generate Project Content

Threads 4| Mew Thread ]  HAL/Common Stacks 4] Mew Stack > | Remove
v ¢ HAL/Common = = ’ ~
4 g_ioport /0 Port Driver on r_ioport & g_lupurt (o] Fur:t 42 g_ellc ELC Driver on 4 g_uart) UART Driver on r_sci_uart
river on r_icpo r_elc
4 g_elc ELC Driver on r_elc A e
4 g_uart0 UART Driver on r_sci_uart @ @ @
ry
I I
4 g_transferl Transfer 4 g_transfer! Transfer
Objects &) New Object » Driver on r_dtc 1 Driver on r_dtc 0
@ @
v
Summary | BSP | Clocks | Pins | Interrupts | Stacks| Components
% Pin Conflicts 4 MCU Package [ Console | [ Properties 52 P |

g_uart0 UART Driver on r_sci_uart

Mag

B e BlE0 Tignerl eyl

Settings
Receive Interrupt Priority Priority 2
Transmit Data Empty Interrupt Priority Priority 2
Transmit End Interrupt Priority Priority 2
Error Interrupt Priority Priority 2
Figure 20: Configuring Interrupt on the Stacks tab
Interrupts

In the Interrupt tab, the user can bypass a peripheral interrupt and have user-defined ISRs for the
peripheral interrupt. This can be done by adding a new event with the user define tab (New User
Event).

8 *[MyProject] RA Configuration % ==

Interrupts Configuration
P g Generate Project Content

User Events 4| New User Event > |5
Event ISR
Allocations
Interrupt Event ISR
(1] SCI0 RXI (Receive data full) sci_uart_rxi_isr
1 SCI0 TXI (Transmit data empty) sci_uart_t_isr
2. SCID TEI (Transmit end) sci_uart_tei_isr
3 SCI0 ERI (Receive error) sci_uart_eri_isr

Summary:BSP:C\ucks PmsStacks Cumponents:
Figure 21: Configuring interrupt in Interrupt Tab
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& *[MyProject] RA Configuration 33 brc > |Package 33
. . EDMAC ]
Interrupts Configuration Genel Iore g
EPTPC >
User Events 1.| 4] New User Eve | Ecu N
Event ISR CLEDE ?
GPT >
Icu >
c >
IOPORT 3
IWDT )
Allocations JPEG >
Interrupt Event . SCID RXI (Receive data full) I[3. scio B
0 SCIORXI (Receive data full) SCI0 TXI (Transmit data empty) sci >
1 SCID TXI (Transmit data empty) SCIO TEI (Transmit end) SCl2 >
2 SCID TEI (Transmit end) SCID ERI (Receive error) SCI3 >
3 SCIOERI (Receive error) SCI0 AM (Address match event) sCl4 »
SCI0 RX| OR ERI (Receive data full/Receive) SCI5 b3
Sﬁmmary ES‘P C“Io(‘k;‘f‘liins'Intarrupts.Staéks.;“Componentif. ) QsPI > sCle >
) RTC > scr7 >
- scE > s >
2. 5CI By sCig >
SDHIMMC >
<ol 3 {

Figure 22: Adding user-defined event

Enter the name of ISR for the new user event.

B New User Event x ‘

Enter the name of the ISR for the new user event:

| user_dE‘ﬁned_sm_uart_rxl_\srl ‘

Cancel
Figure 23: User-defined event ISR

48k *[MyProject] RA Configuration 53 = O

Interrupts Configuration
P g Generate Project Content

User Events 4] New User Event » 3

Event ISR

SCI0 RXI (Receive data full) user_defined_sci_uart_rxi_isr
Allocations

Interrupt Event ISR

D SCID RXl (Receive data full) user_defined_sci_uart_nxi_isr I

1 SCI0 TXI (Transmit data empty) sci_uart_txi_isr

2 SCID TEI (Transmit end) sci_uart_tei_isr

3 SCID ERI (Receive error) sci_uart_eri_isr

:‘:ummary;éS’P ;C\oéls jli\ns Interrupts | Stacks| tbmponer;ts'

Figure 24: Using a user-defined event

2.2.5.5 Viewing Event Links

The Event Links tab can be used to view the Event Link Controller events. The events are sorted by
peripheral to make it easy to find and verify them.
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9% [Blinky] RA Configuration §3 = 0
0

Event Links Configuration ;
Generate Project Content

Allocations

Peripheral Function Event

, A)} No allocation
GPT (B) No allocation

GPT (C) Mo allocation
GPT (D) No allocation
GPT (E) No allocation
GPT (F) No allocation
GPT (G) No allocation
GPT (H) No allocation
ADC12A0 No allocation
ADC12B0 No allocation
ADC12A1 No allocation

Summary | BSP | Clocks | Pins | Interrupts | Event Links | Stacks | Components

Figure 25: Viewing Event Links

Like the Interrupts tab, user-defined event sources and destinations (producers and consumers) can
be defined by clicking the relevant New User Event button.

Note
When selecting an ELC event to receive for a module (or when manually defining an event link), only the events
that are made available by the modules configured in the project will be shown.

2.2.6 Adding Threads and Drivers

Every FreeRTOS-based RA Project includes at least one RTOS Thread and a stack of FSP modules
running in that thread. The Stacks tab is a graphical user interface which helps you to add the right
modules to a thread and configure the properties of both the threads and the modules associated
with each thread. Once you have configured the thread, e2 studio automatically generates the code
reflecting your configuration choices.

For any driver, or, more generally, any module that you add to a thread, e2 studio automatically
resolves all dependencies with other modules and creates the appropriate stack. This stack is
displayed in the Stacks pane, which e2 studio populates with the selected modules and module
options for the selected thread.

The default view of the Stacks tab includes a Common Thread called HAL/Common. This thread
includes the driver for I/0 control (IOPORT). The default stack is shown in the HAL/Common Stacks
pane. The default modules added to the HAL/Common driver are special in that the FSP only requires
a single instance of each, which e2 studio then includes in every user-defined thread by default.

In applications that do not use an RTOS or run outside of the RTOS, the HAL/Common thread
becomes the default location where you can add additional drivers to your application.

For a detailed description on how to add and configure modules and stacks, see the following
sections:

e Adding and Configuring HAL Drivers
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e Adding Drivers to a Thread and Configuring the Drivers

Once you have added a module either to HAL/Common or to a new thread, you can access the
driver's configuration options in the Properties view. If you added thread objects, you can access
the objects configuration options in the Properties view in the same way.
You can find details about how to configure threads here: Configuring Threads
Note

Driver and module selections and configuration options are defined in the FSP pack and can therefore change

when the FSP version changes.

2.2.6.1 Adding and Configuring HAL Drivers

For applications that run outside or without the RTOS, you can add additional HAL drivers to your
application using the HAL/Common thread. To add drivers, follow these steps:

1. Click on the HAL/Common icon in the Stacks pane. The Modules pane changes to
HAL/Common Stacks.

{85 *[MyProject] RA Configuration 2 i
Click here to add )
Stacks Configuration
g newmodiile Generate Project Content
Threads i ; 5 = HAL/Common Stacks 47| New Stack > s %] Remove
v g HAL/Common
& g_ioport /0 Port Driver an r_ioport 4 g_ioport [/0 Port & g_wdt) Watchdog o g_cgch CGC Driver on

M Di t Drivi dt
4 g_wdt0 Watchdog Driver on r_wdt i itk e

= g_cgch CGC Driver on r_cge

Objects

Summary.BSP Clocks | Pins | Interrupts Eventhk; Components

Figure 26: e2 studio Project configurator - Adding drivers

2. Click New Stack to see a drop-down list of HAL level drivers available in the FSP.

3. Select a driver from the menu New Stack > Driver.
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45 “[MyProject] RA Configuration 53 = B | gPackage X

Stacks Configuration
9 Generate Project Content

Threads = HAL/Commoen Stacks 4] New Stack >
v & HAL/Common - - Amazon FreeRTOS >
47 g_ioport /0 Port Driver on r_ioport & [gl_rlssrﬂ:nhr?nzﬂnr:t Arm > HEJ
Driver > Analog >
Middleware > CapTouch >
SEGGER > Connectivity iy
& Search.. Graphics »
Input >
Monitoring »
Network »
Power ?
Storage »
Objects System >
RTC Driver on r_rtc Timers >
»

Timer Driver on r_agt Transfer

(¢ @ ¢

Timer Driver on r_gpt

Summary |BSP | Clocks | Pins | Interrupts | Event Links | Stacks | Components

Figure 27: Select a driver
4. Select the driver module in the HAL/Common Modules pane and configure the driver
properties in the Properties view.
e2 studio adds the following files when you click the Generate Project Content button:
e The selected driver module and its files to the ra/fsp directory

e The main() function and configuration structures and header files for your application as
shown in the table below.

File Contents Overwritten by Generate
Project Content?

ra_gen/main.c Contains main() calling Yes
generated and user code. When
called, the BSP already has
Initialized the MCU.

ra_gen/hal_data.c Configuration structures for HAL | Yes
Driver only modules.

ra_gen/hal_data.h Header file for HAL driver only | Yes
modules.

src/hal_entry.c User entry point for HAL Driver | No

only code. Add your code here.

The configuration header files for all included modules are created or overwritten in this folder:
ra_cfg/fsp_cfg

2.2.6.2 Adding Drivers to a Thread and Configuring the Drivers
For an application that uses the RTOS, you can add one or more threads, and for each thread at least
one module that runs in the thread. You can select modules from the Driver dropdown menu. To add

modules to a thread, follow these steps:

1. In the Threads pane, click New Thread to add a Thread.
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48 *[Blinky] RA Configuration £3 al e -0

Stacks Configuration

Threads | & Mew Thread | 3] Remove [=]  Mew Thread Stacks 4] New Stack> =

v g‘si‘ HAL/Common f @k Add RA stacks to the selected thread by using the 'Mew Stack »' toolbar button (above), or

42 g ioport 1O Port Driver on r_ioport /
2 Mew Thread

Generate Project Content

¥' by pasting here from the clipboard.

Objects 4| New Object >

Summary | BSP | Clocks | Pins | Interrupts | Stacks| Components

I#] Problems =) Tasks [E) Console | [T Properties 2% |3 Call Hierarchy @ Smart Browser Memory Usage

New Thread
- Property Value
Scting: » Common
w Thread

Symbol new threadd Enter the name of your thread
MName [New Thread | here example: My Thread
Stack size (bytes) 1024
Priority 1

<

Figure 28: Adding a new RTOS Thread on the Stacks tab

2. In the Properties view, click on the Name and Symbol entries and enter a distinctive
name and symbol for the new thread.

Note
e2 studio updates the name of the thread stacks pane to My Thread Stacks.

3. In the My Thread Stacks pane, click on New Stack to see a list of modules and drivers.
HAL-level drivers can be added here.

8% *[MyProject] RA Configuration 2 = O  §&lPackage 2

Stacks Configuration
g Generate Project Content

Threads 42 New Thread #| Remove []  Mew Thread Stacks 4] New Stack
Amazon FreeRTOS >
v & ;F{';L*’Cummorn i "‘-‘ Adbd RA s:ackshto tI;a sel:;tadl.thbreaddby using the 'T Arm > ) —
" I‘\Jejjr\;f:a:h(] Port Driver on r_ioport LW or by pasting here from the clipboard. Drees 5 e 3
M CapTouch »
& 12C Master Driver on r_iic_master Connectivity »
@ 12C Slave Driver on r_iic_slave Graphics ¥
& 125 Driver on r_ssi Input »
“  SP| Driver on r_spi Monitoring »
Objects ‘a Mew Object » @ UART Driver on r_sci_uart Power »
Storage >
System »
Timers »
Transfer >

Summary | BSP | Clocks | Pins | Interrupts | Stacks| Components

Figure 29: Adding Modules and Drivers to a thread

4. Select a module or driver from the list.

5. Click on the added driver and configure the driver as required by the application by
updating the configuration parameters in the Properties view. To see the selected module
or driver and be able to edit its properties, make sure the Thread containing the driver is
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highlighted in the Threads pane.

48 [MyProject] RA Configuration I3

Stacks Configuration

Threads

v & HAL/Common

47 g_ioport /O Port Driver on r_ioport
w i New Thread

4 g_wdt) Watchdog Driver on r_wdt

Objects 4| Mew Object >

4] New Thread 2] Remove |5

g_wdt0 Watchdog Driver on r_wdt Stacks &) New Stack >

4 g wdtD Watchdog
Driver on r_wdt

@

Summary | BSP | Clocks | Pins | Interrupts | Stacks

["’m Pin Conflicts & Console | [T Properties 3

g_wdt0 Watchdog Driver on r_wdt

Property
Common
v Module g_wdt) Watchdog Driv
Name

Settings

Timeout

Clock Division Ratio
Window Start Position
Window End Position
Reset Control

Stop Control

MMI Callhack

Components

Value

g_wdt0

16,384 Cycles

PCLK/8192

100% (Window Position Not Specified)
0% (Window Position Not Specified)
Reset Qutput

WDT Count Disabled in Low Power Mode
NI

=]

Generate Project Content

i Remove

Figure 30: Configuring Module or Driver properties

6. If needed, add another thread by clicking New Thread in the Threads pane.

When you press the Generate Project Content button for the example above, e2 studio creates

the files as shown in the following table:

File Contents

Overwritten by Generate

Project Content?

ra_gen/main.c Contains main() calling Yes
generated and user code. When
called the BSP will have

initialized the MCU.

ra_gen/my_thread.c Generated thread "my_thread" |Yes
and configuration structures for

modules added to this thread.

Header file for thread Yes

"my_thread"

ra_gen/my_thread.h

ra_gen/hal _data.c Configuration structures for HAL | Yes

Driver only modules.

ra_gen/hal_data.h Header file for HAL Driver only |Yes

modules.

src/hal_entry.c User entry point for HAL Driver | No

only code. Add your code here.

src/my_thread_entry.c User entry point for thread No
"my_thread". Add your code

here.
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The configuration header files for all included modules and drivers are created or overwritten in the

following folders: ra_cfg/fsp_cfg/<header files>

2.2.6.3 Configuring Threads

If the application uses the FreeRTOS, the Stacks tab can be used to simplify the creation of

FreeRTOS threads, semaphores, mutexes, and event flags.

The components of each thread can be configured from the Properties view as shown below.

New Thread

Settings Property Value
v Common
General
Hooks
Stats
Memory Allocation
Co-routines
Timers
Optienal Functions
v Thread

Symbol new_thread
Mame Mew Thread
Stack size (bytes) 1024
Priority L

Figure 31: New Thread Properties

The Properties view contains settings common for all Threads (Common) and settings for this

particular thread (Thread).

For this thread instance, the thread's name and properties (such as priority level or stack size) can
be easily configured. e2 studio checks that the entries in the property field are valid. For example, it
will verify that the field Priority, which requires an integer value, only contains numeric values

between 0 and 9.

To add FreeRTOS resources to a Thread, select a thread and click on New Object in the Thread
Objects pane. The pane takes on the name of the selected thread, in this case My Thread Objects.

48% *[Blinky] RA Configuration &2 | [£] hal_entry.c

Stacks Configuration

Threads & New Thread | Remove [5]  Mew Thread Stacks 4] New Stack >

v & HAL/Common

4% g_ioport /0 Port Driver on r_iopol
v i New Thread

45 g_timerD Timer Driver on r_gpt @

4 g_timerD Timer Driver
onr_gpt

Click to add new Thread

o 5 Objects to New Thread

Objects s
T i tiew Dbicel @  Event Groups

@ g_new_event flagsOEve @& Mutex |
@ g new_queued Queve! @ Queue |

— | @ Semaphore I
Summary | BSP | Clacks | Pins Iﬁmﬁ's{ai‘k‘s‘”wrments
[ Properties £
g_new_queue0 Queue
Settings Property Yalue
Name MNew Queue I
Symbol g_new_queued
Item Size (Bytes) 4
Queue Length (items) 20

Figure 32: Configuring Thread Object Properties

=

Generate Project Content

%] Remove
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Make sure to give each thread object a unique name and symbol by updating the Name and
Symbol entries in the Properties view.

2.2.7 Reviewing and Adding Components

The Components tab enables the individual modules required by the application to be included or
excluded. Modules common to all RA MCU projects are preselected (for example: BSP > BSP >
Board-specific BSP and HAL Drivers > all > r_cgc). All modules that are necessary for the
modules selected in the Stacks tab are included automatically. You can include or exclude

additional modules by ticking the box next to the required component.

{8 [MyProject] RA Configuration 33

Components Configuration

Component

w rabm2

w @ rabm3
[¥] device
[@] device
7| device
] device
device
device

device
] device
[F] device
| device
7| device
¥ fsp
~ @ty CMSIS
v @ CMSISS
[¥] CoreM
v ¥ Common
v @ all
¥| fsp_commen
v gty HAL Drivers
w @ all
[ r_acmplp

Summary |BSP | Clocks Pins.\nterrupts Sta{k

Version

0.6.0
0.6.0
0.6.0
0.6.0
0.6.0
0.6.0
0.6.0
0.6.0
0.6.0
0.6.0
0.6.0
0.6.0

0.6.0

0.6.0

0.6.0

Description

Board support package for RTFAGM3IAHICFC
Board support package for RAGM3

Board support package for RTFAGM3IAF2CBG
Board support package for RFTFAGM3IAFZCLK

Board support package for RTFAGM3IAFICFB

Board support package for RFFAGM3IAF3CFC

Board support package for RTFAGM3IAFICFP

Board support package for RTFABM3AH2CBG
Board support package for RTFAGM3IAH2ZCLK
Board support package for RFTFAGM3IAHICFB
Board support package for RTFAGM3IAH3CFP
Board support package for RAGM3

Arm CMSIS Version 5 - Core (M)

Board Support Package Common Files

Low Power Analog Comparator

Figure 33: Components Tab

Variant

R7FAGM3AH3CFC

R7FAEM3AFZCBG
R7FAGM3AFZCLK
R7FAGM3AF3CFB
R7FAGM3AF3CFC
R7FAGM3AF3CFP
R7FA6M3AHZCBG
R7FAEM3AHZCLK
R7FAGM3AH3CFB
R7FAGM3AHICFP

While the components tab selects modules for a project, you must configure the modules
themselves in the other tabs. clicking the Generate Project Content button copies the .c and .h
files for each component for a Pack file into the following folders:

* ra/fsp/inc/api
 ra/fsp/inc/instances

e ra/fsp/src/bsp

» ra/fsp/src/<Driver_ Name>

e2 studio also creates configuration files in the ra_cfg/fsp_cfg folder with configuration options
included from the remaining Stacks tabs.

2.2.8 Writing the Application

Once you have added Modules and drivers and set their configuration parameters in the Stacks tab,
you can add the application code that calls the Modules and drivers.

Note

To check your configuration, build the project once without errors before adding any of your own application code.
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2.2.8.1 Coding Features

e2 studio provides several efficiency improving features that help write code. Review these features
prior to digging into the code development step-by-step sections that follow.

Edit Hover

e2 studio supports hovers in the textual editor. This function can be enabled or disabled via Window
> Preferences > C/C++ > Editor > Hovers.

BH Preferences

type filter text

Code Style

Core Build Toolchains

Debug

v Editor

Content Assist
Encrypted Files
Folding
Hovers
Mark Occurrences
Save Actions
Scalability
Syntax Coloring
Templates
Typing

File Types

Indexer

Language Mappings

New C/C++ Project Wizard

Property Pages Settings

Renesas

Task Tags

Template Default Values

@ @

Hovers

Expand vertical ruler icons upon hovering [does not affect open editors)
Text Hover key modifier preferences:
Pressed Key Modifier While Hoverin:

Text Hover Name
[+] Combined Hover

J Debugger

:l Renesas |O Register Help

:l RenesasCDocHover

|| Problem Description

J Documentation

j Macro Expansion

7] Source Shift
:l Annotation Description

Pressed key modifier while hovering:‘
Description:

Tries the hovers in the sequence listed below and uses the one which fits best
for the selected element and the current context.

Restore Defaults Apply

Apply and Close Cancel

Figure 34: Hover preference

To enable hover, check Combined Hover box. To disable it, uncheck this box. By default, it is
enabled. The Hover function allows a user to view detailed information about any identifiers in the
source code by hovering the mouse over an identifier and checking the pop-up.

bsp_leds_t leds;

/* LED state variable */
ioport_level_t level = IOPORT_LEVEL_HIGH;

A SELR- B AR
4 hal_data.h
& hal_entry(void)

[* Get LED information for this board */

R_BSP LedsGet(&leds);

Name: R_BSP_LedsGet

| & Prototype: ssp err tR BSP LedsGet (bsp leds t *p leds)
| Description:
. ._': Return information about the LEDs on the current board.
| £ z ] . 2 . :
| 55 Structure with LED information. p_leds Pointer to structure where LED info is stored.
|
| £
| &2
i I J
| G

63 {
| S level = IOPORT_LEVEL_LOW;
| }

Figure 35: Hover Example
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Welcome Window

The e2 studio Welcome window displays useful information and common links to assist in
development. Check out these resources to see what is available. They are updated with each
release, so check back to see what has been added after a new release.

RA_Workspace - Blinky/src/hal_entry.c - € studio - O X
File Edit Source Refactor MNavigate Search Project RenesasViews Run  Window Help
5' (@) Welcome 31 ] fafEH=-~
s
il RENESAS Welcome to e2 studio >
Workbench
Create a new e2 studio C/C++ project Get an overview of the features
Import existing e studio projects from the Go through tutorials

filesystem or archive

Try out the samples
Review the IDE's most fiercely contested ¥ B

preferences

Find out what is new
Open a file from the filesystem

M1 aiways show Welcome at start up

B

Figure 36: Welcome window

Cheat Sheets

Cheat sheets are macro driven illustrations of some common tasks. They show, step-by-step, what
commands and menus are used. These will be populated with more examples on each release.
Cheat Sheets are available from the Help menu.
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RA_Workspace - Blinky/src/hal_entry.c - € studio - m} X
File Edit Source Refactor Navigate Search Project RenesasViews Run Window Help
Q%] #5 Debug v || 9 Blinky Debug v . @ Welcome
> D DS F - Q@S & i 4D Gl () Help Contents
%’ Search
= Show Contextual Help
[ Project Explorer 53 = G| & Y = B {8 [Blinky] RA Configuration
e o ) . ] Show Active Keybindings... Ctrl+Shift
v [ Blinky [Debug] A 1 #include ) )
m) Includes [ 2 #include Tips and Tricks...
@ ra #include ' & Report Bug or Ephgncement...
(£ ra_gen 5 void R_BSk Cheat Sheets...
v G src 5
| hal_entry.c @ * The RA RA Helpdesk
(= ra_cfg void _hﬂ_‘ & RenesasRulz Community Forum
L? sc.ript 47 Add Renesas Toclchains
= Bllnk_y Deb_ug.launch %y  Perform Setup Tasks...
20¢ configurationxml }
-| RVFA6M3AH3CFC.pincfg % Check for Updates
5 ra_cfg.bt v - i _T,h'_l,swf: (g Install New Software...
< > < Renesas e2 studio feedback
[T] Properties 52 = 08 [:Q Pin Conflic' §& |AR Embedded Workbench plugin manager...
B 3 B v |Qitems B About e studio
Property Value Descrip!ion o L L}

Developer Assistance

Figure 37: Cheat Sheets

FSP Developer Assistance provides developers with module and Application Programming Interface
(API) reference documentation in e2 studio. After configuring the threads and software stacks for an
FSP project with the RA Configuration editor, Developer Assistance quickly helps you get started
writing C/C++ application code for the project using the configured stack modules.

1. Expand the project explorer to view Developer Assistance
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JL
d
q
0
(I

iy Project Explorer &3 B <
v 15 Blinky
m) Includes
2 ra
(2 ra_gen
(2 src
= ra_cfg
(= script
2| Blinky Debug.launch
&% configuration.xml
=] R7TFABM3AH3CFC.pincfg
= ra_cfg.bd
) RASM3-EK pincig

v (2) Developer Assistance
v % HAL/Common
& g_ioport /O Port Driver on r_ioport
47 g_elc ELC Driver onr_elc
4 g_adc0 ADC Driver on r_adc

Figure 38: Developer Assistance

2. Expand a stack module to show its APIs

v (@ DevelnparAssist;nce
v gt HAL/Common

42 g_joport |70 Port Driver on r_ioport
47 g_elc ELC Driver on r_elc
w & g_adch ADC Driver on r_adc

~ @ fsp_err t R_ADC_Open(adc_ctrl_t *p_ctrl, ade_cfg_t const *const p_cfg)
| Call R_ADC_Open()

v @ fsp_err t R_ADC ScanCfg(ade_ctrl_t *p_ctrl, adc_channel_cfg_t const *const p_channel_cfg)
|2 Call R_ADC ScanCfg()

v @ fsp_err t R_ADC InfoGet(adc_ctrl_t *p_ctrl, adc_info_t *p_adc_info)
[t Call R_ADC InfoGet()

v @ fsp_err_t R_ADC ScanStart(adc_ctrl_t *p_ctrl)
|23 Call R_ADC ScanStart()

v @ fsp_err_t R_ADC_ScanStop(adc_ctrl_t *p_ctrl}
|23 Call R_ADC_ScanStop()

v @ fsp_err t R_ADC StatusGet{adc_ctrl_t *p_ctrl, ade_status_t *p_status)
|24 Call R_ADC_StatusGet()

~ @ fsp_err t R_ADC_Read(adc_ctrl_t *p_ctrl, adc_channel_t const reg_id, uint16_t *const p_data)
[t3 Call R_ADC_Read()

~ @ fon errtR ADNC Read32(ade ctrl t *n ctrl ade channel t const ren id uint3? + *const 0 datal

Figure 39: Developer Assistance APIs

]

3. Dragging and dropping an API from Develop Assistance to a source file helps to write source

code quickly.
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~ [(7) Developer Assistance
v g HAL/Common
4 g_iopert I/0 Port Driver on r_ioport
48 g_elc ELC Driver on r_elc
v & g_adc0 ADC Driver on r_adc

v @ fsp_em_t R_ADC_Open(adc_ctrl_t *p_ctrl, adc_cfg_t const "const p_cfg)
b= Call R_ADC_Openi)

v @ fsp_em_t R_ADC_ ScanCfg(adc_ctrl_t *p_ctr, adc_channel_cfg_t const *const p_channel_cfg)
b= Call R_ADC_ScanCfg()

v @ fsp_em_t R_ADC InfoGet(adc_ctrl_t *p_ctrl, adc_info_t *p_adc_info)
= Call R_ADC InfoGet()

v @ fsp_em_t R_ADC_ ScanStart(adc_ctrl_t "p_ctrl)
[z Call R_ADC_ScanStart()

v @ fsp_em_t R_ADC_ ScanStop(adc_ctrl_t "p_ctrl)
bz Call R_ADC_ScanStop()

v @ fsp_em_t R_ADC StatusGet(adc_ctrl_t *p_ctrl, adc_status_t *p_status)
= Call R_ADC_StatusGet()

v @ fsp_em_t R_ADC_Read(adc_ctrl_t *p_ctrl, adc_channel_t const reg_id, uint16_t “const p_data)
= Call R_ADC_Read()

~ @ fan err t R ANC Read3?fade ctrl + *n ctrl ade channel t conct rea id uint3? t “conet o datal a2

<

Figure 40: Dragging and Dropping an API in Developer Assistance

Information Icon

Information icons are available on each module in the thread stack. Clicking on these icons opens a
module folder on GitHub that contains additional information on the module. An example information
Icon is shown below:

47 g_ioport 1/0 Port

\ Driver on r_ioport
D

Figure 41: Information icon

Smart Manual

Smart Manual is the view that displays information (register information/search results by keyword)
extracted from the hardware user's manual. Smart Manual provides search capability of hardware
manual information (register information search and keyword search result) and provides a view
displaying result.

You can open Smart Manual view by selecting the menu: Renesas Views > Solution Toolkit >
Smart Manual. Register search and Keyword search are both available by selecting the appropriate
tab.
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(%3 Pin Conflicts I} Smart Manual i3

Register Search Keyword Search

port v|I Go ]Device:RA6M

No search results available.

<

Figure 42: Smart Manual

2.2.8.2 RTOS-independent Applications

To write application code:

1.

2.
. In the Project Configuration view, click the Generate Project Content button.

Add all drivers and modules in the Stacks tab and resolve all dependencies flagged by e2
studio such as missing interrupts or drivers.
Configure the drivers in the Properties view.

. In the Project Explorer view, double-click on the src/hal_entry.c file to edit the source file.

[ Project Explorer 33

]
£

= (=
-
~

125 Blinky
T FSP_project
w 15 MyProject [Debug]

#éb.
